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P hotoshop CS3 is now at version 10 of this 
phenomenally successful program (well twelfth 
actually, if you count versions 2.5 and 5.5). And 
it all started almost twenty years ago in late 

1987, when Thomas Knoll with his brother John, created 
the first prototype version of Photoshop. Photoshop CS3 
has come on a long way since then, so much so that even 
in a big book like this there is only enough space to cover 
the features that are of specific interest to photographers. 
In this introductory chapter I have provided a shortlist of 
what’s new and offered a few brief examples of some of the 
things that you can now do in Photoshop and Bridge CS3.

What’s New in
Adobe Photoshop CS3

Chapter 1

Martin Evening’s Adobe Photoshop for Photographers 
titles have become classic reference sources, the only 
Photoshop books written to deal directly with the needs 
of photographers. Whether you are an accomplished 
user or just starting out, these books contain a wealth 
of practical advice, hints and tips to help you achieve 
professional-looking results. Adobe Photoshop CS3 
for Photographers, will be published by Focal Press, 
an imprint of Elsevier in the Spring of 2007, shortly 
after the official release of Photoshop CS3. More 
information about the book and how to order it will be 
made available on the book website, closer to the time of 
publication: www.photoshopforphotographers.com.

ISBN: 0-240-52028-9 (old style ISBN)
ISBN: 978-0-240-52028-5 (new style ISBN)
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New interface design
The most immediately noticeable difference in Photoshop 
CS3 is the new interface design, which is part of a wider 
strategy to give all the applications in the CS3 creative suite 
a more unified look and therefore make the interfaces more 
consistent when switching between applications. 
	 To start with you will notice how the Tools palette is 
presented in a single column. Now that we are all using 
bigger displays, there is no real need for the old two 
column version. You will also notice that the palette well 
has disappeared from the tool Options bar. The palettes 
can now be displayed on the left- or right-hand side of the 
screen grouped into multiple column docking zones and 
easily hidden or made visible by rolling the mouse to either 

Figure 1.1 The Photoshop CS3 Windows PC layout.

Pen path appearance
The path outlines that are created when 
you use the pen tool have now been made 
slightly bolder and are easier to see on 
the display. The same also applies when 
drawing a freehand selection using the 
lasso tool.
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Figure 1.2 The new Photoshop CS3 Mac OS X layout. In this screenshot the 
Layers, Channels and Paths palettes were placed in a third column docking zone. 
You can see here that if I click on a palette icon, this will quickly expand to reveal the 
normal full size palette. 

side of the screen. The main intention here has been to 
create the most efficient use of screen space when working 
with the palettes and image documents. Palette docking is 
easier to accomplish and in the Windows layout in Figure 
1.1 you can see how the palettes in the second column from 
the right have been compressed into tabbed palette mode. 
All palettes can now be collapsed in this way so that the 
palettes are represented as icons that graphically indicate 
the identity of each palette. To collapse a palette docking 
zone, you just click on the double arrow button at the top of 
each palette zone and click again to expand the palettes.

Figure 1.3 Don’t like the single row palette? 
Well, a click on the double-arrow icon in the 
Palette tab will allow you to toggle between the 
single and double row versions of the Tools 
palette. 
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Figure 1.4 The new Performance preferences dialog, showing the scratch disk and 
memory allocation.

Performance
Various things have been done to improve the performance. 
Mac users in particular will benefit from the program 
being in universal binary, so that Photoshop CS3 is now 
fully optimized for the latest Macintosh Intel processor 
computers. Windows users meanwhile will notice faster 
startup times. 
	 The Photoshop performance preferences offer guidance 
on how much RAM memory you should ideally allocate 
to Photoshop. And the scratch disk preferences are now 
presented in a way that makes it easier to decide which 
scratch disks are used and in what order of priority.

GPU settings
Instead of relying on the Central Processor 
Unit (CPU) for the graphics processing, 
some Graphics Processor Units (GPUs) 
are capable of providing faster graphics 
rendering. Where a GPU type card 
is detected, checking the Enable 3D 
Acceleration box will improve the image 
display performance. The 3D support 
will also improve the performance of the 
brushes. When using a pressure sensitive 
pen, the brushes response will feel much 
more sensitive and responsive.

Camera Raw 4.0
Camera Raw 4.0 offers several new raw image processing 
additions that overlap nicely with the Adobe Photoshop 
Lightroom program (both share the same Adobe Camera 
Raw processing engine). These include things like the 
Recovery and Fill Light controls for better tonal editing of 
the highlight and shadow detail and a Vibrance adjustment 
for boosting the saturation, but with less risk of clipping 
(and built-in skin tone color masking).
	 Dig deeper through the new Camera Raw interface and 
you will notice how the tabbed panel controls mirror all the 
adjustments that you will find in the Lightroom program, 
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Figure 1.6 Shown here is the new Adobe Camera Raw 4.0 plug-in dialog, 
displaying the Basic panel, which features the new ACR controls such as: Recovery, 
Fill Light and Vibrance adjustments.

This means that you now have the ability to apply what are 
known as parametric tone Curve adjustments, instead of 
point tone curve corrections. You can apply hue, saturation 
and luminance type adjustments (with improved controls 
over Photoshop’s  Hue/Saturation) and custom grayscale 
conversions. Plus you have the ability to correct for red eye 
in flash photographs, use the retouch tool to spot images 
and intelligently synchronize the spotting across several 
images at once. But more importantly, because Lightroom 
and Camera Raw now share the same controls, settings 
can be synchronized precisely when you switch between 
editing an image in Camera Raw via Bridge or Photoshop 
and editing the same image via Lightroom. The other big 
change is that you can now set a preference to edit non-
raw images such as JPEGs and TIFFs directly, using the 
Camera Raw dialog.

Figure 1.5 Here are the Camera Raw Tone 
Curve controls, shown using the Parametric Tone 
Curve editor mode.
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Figure 1.7 The new Photoshop CS3 Curves dialog.

New Curves
With 22 image adjustment methods to choose from, it 
is hardly any wonder that Photoshop users get confused 
when trying to decide which image adjustment tool is 
the best one to use. For photographic work, the only 
tonal correction tools you ever really needed were Levels 
and Curves. Photoshop CS3 has at long last merged 
the functionality of Levels into the Curves dialog. At 
the bottom of the curve grid are Shadow and Highlight 
slider controls with Show Clipping controls to help you 
precisely judge where to set the shadows and highlights 
endpoints. As with Levels, you can also preview the image 
in Threshold mode to help judge the endpoints by holding 
down the O A key as you drag on either of these two 
sliders. In Figure 1.7 you can see the new Curve display 
options which in this example were configured so that the 
Curves adjustments made to the individual color channels 
can be displayed overlaying the main composite channel 
curve shape.

New layer/paint blending modes
It would be nice if the Curves dialog 
allowed you to control the blending mode 
from within the dialog itself, so that you 
could set it to, say, Color or Luminosity. 
But alas not this time around. However, 
two new blending modes have been added 
to the blend menu list. Lighter color is 
similar to the Lighten mode, except it 
works on all channels instead of working 
on a per-channel basis. Darker color is 
similar to the Darken mode, except it 
works on all channels instead of working 
on a per-channel basis. These two new 
blend modes are quite subtle in the way 
they work. I have found both to be useful 
whenever I wish to control the blending 
of a Curves adjustment so that only the 
pixels that are made lighter, or the pixels 
that are made darker, are the ones that 
get adjusted. These blend modes are 
often great to use when applying Curves 
adjustment layers.
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Figure 1.8 The new, revised Brightness/Contrast image adjustment closely matches 
the Brightness and Contrast slider adjustments found in the Adobe Camera Raw 
dialog. 

New Brightness and Contrast
It may not seem such a big deal, but the Brightness/
Contrast image adjustment has been updated so that you 
can now actually use it safely on photographic images 
without risk of clipping the highlight or shadow detail. This 
was always the problem with the old Brightness/Contrast 
command, even if users were unaware of the harm it could 
do when being used to adjust photographs. The legacy 
operating mode is still there if you need the old behavior 
back.

Eyedropper options
New eyedropper tool sample size options 
extend the sample size range. Previously 
the options included: Sample Point, 3 x 3 
and 5 x 5. In addition to this the new 
sample sizes include: 11 x 11, 31 x 31, 
51 x 51, 101 x 101 pixels.
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Figure 1.9 In the example shown here I applied a Black & White image adjustment 
to the image in which I adjusted the color sliders so as to keep the sky dark relative 
to the other colors in the original RGB image. The Tint option was selected to apply a 
color wash to the resulting black and white photograph.

Black & White adjustments
It is now easier to convert images from color to black and 
white via a single dialog interface. The new Black & White 
adjustment is available as a direct image adjustment or as 
an adjustment layer. The slider settings will allow you to 
adjust the proportions of the color components that are 
used to create a black and white conversion and will help 
you come up with many different types of black and white 
conversions.
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Align controls
The Edit menu includes an Auto-Align Layers and Auto 
Blend Layers commands. The Auto-Align command can 
be used to automatically combine two or more layers and 
bring them into register with each other using one of the 
alignment options shown on the right. In the example 
given below, I wanted to combine the best of the two 
photographs shown below right, in order to produce a 
more successful composite image that blended the best of 
these two pictures. Auto-Align Layers can also be useful 
for registering misaligned images when working with 
the Merge to HDR command. The Auto-Blend Layers 
command takes the auto alignment one stage further 
and attempts to blend layers together more smoothly by 
applying layer masks of varying opacity to each layer, 
evening out any differences in brightness between each of 
the layers.

Figure 1.11 In this example I combined the two images on the right by adding 
one above the other as a new layer. I then made a shift selection of both layers to 
temporarily group them. I then went to the Edit menu and chose Auto-Align Layers... 
and selected the Perspective option from the Auto-Align Layers dialog. This made 
Layer 1 register in alignment with the Background layer. To merge the images 
together I added a layer mask filled with black to Layer 1 and painted with white to 
reveal the girl on the left and blend seamlessly with the layer below.

Figure 1.10 Here are the Auto-Align options 
for aligning layers. Auto can do a pretty amazing 
job of automatically registering layers. But in this 
instance, the Perspective alignment worked best 
to register the group portraits. 
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Automatic Photomerge
The new Align Content processing has also allowed the 
Photoshop team to update the Photomerge feature such that 
it can now do a really good job of automatically aligning a 
group of images, bypassing the need to use the interactive 
Photomerge layout dialog.

Figure 1.12 Shown here is the very first attempt at using Photomerge in Auto 
mode to align a set of 11 photographs, all shot from the same position. I have used 
Photomerge quite a bit in the past, but the improved accuracy of the results has really 
been quite impressive. 
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Clone Source palette and options
There are a number of new options for both the clone 
stamp and standard healing brush tools. In the tool Options 
bar you have clone source options that will allow you to 
sample from the current layer only or from the current 
layer and those below only, from all layers (ignoring any 
adjustment layers) and all layers (including adjustments). 
	 In Figure 1.13, you can see how I switched on the Show 
Overlay option and adjusted the overlay opacity and blend 
mode so that when rolling the mouse across the image prior 
to positioning the destination point, one can predict more 
accurately how the clone source pixels will register with 
the pixels in the image below.

Figure 1.13 In this example I wanted to sample from the letter ‘O’ on the left to 
repair the gap in the letter ‘O’ on the right. To do this, I switched on the overlay in the 
Clone Source palette, so that while I rolled the cursor over the image, I could predict 
where to click to start cloning and make the source letter register with the destination 
letter. 

Multi point source cloning
The new Clone Source palette will allow 
you to select up to five clone source points 
when working with the clone stamp or 
standard healing brush tools. This feature 
won’t be of so much interest to retouchers 
working on stills photographs, but it is 
something that will be more useful for 
video and film editors who are retouching 
multiple frames in a film sequence.
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Blending multiple images with Stacks
Following on from what is new with Auto-Align Layers and 
Photomerge, there is the Image Stacks feature in Photoshop 
CS3 which is mainly designed for scientific and forensics 
use in determining small differences or similarities between 
a sequence of image frames.
	 But I have also managed to discover a more creative use 
for Image Stacks. Later on in the book I will be showing 
you a step-by-step method (summarized in Figure 1.15) 
in which I took a series of six pictures where there was 
always at least one person walking through a scene and I 
wanted to automatically remove them from the shot. When 
you see this technique demonstrated it does at first look 
quite magical, but there is a logical explanation for how the 
process works. The technique relies mainly on the use of 
the Auto-Align command to align a chosen set of sample 
images together and place them within a grouped smart 
object. After doing a little bit of experimentation I have 
found that if you record at least five or six exposures, this 
should provide enough pictures for Photoshop to process 
in order to work out which pixels appear most frequently 
at any particular spot in the picture and use the most 
commonly occurring pixels only to produce the finished 
blend shown opposite.

Figure 1.14 The selected images shown opposite were aligned together as a Smart 
Object using the Load Files into Stack script from the File menu.

Other applied uses of Image Stacks
The technique shown here can also be 
adapted to merge multiple images shot of 
the same scene and use the Stacks median 
rendering to smooth out the differences 
due to camera noise. Later on in Chapter 5 
I have a really good example of how I was 
able to blend a series of hand-held shots 
that were taken at dusk using the highest 
ISO setting on the camera. A Stacks 
median rendering can do a really good 
job of removing all the noise and give you 
smoother detail in the shadows.

Counting and measuring
The new count tool is probably more useful 
for scientific applications. When you select 
the count tool and use it in manual mode, 
the tool will record each mouse-click as 
a running count, automatically placing a 
count number next to each object you click 
on in the image. For scientists this is a 
useful way to record and identify cells from 
a microscope slide. In automatic mode you 
can click on the Count button in the count 
tool options to count objects automatically, 
but to get this feature to work accurately 
you really need to modify the image 
appearance first to make the objects more 
distinct.

Extended version only
Note that Image Stack rendering and the 
count tool will only be made available in 
the extended version of Photoshop  CS3.
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Figure 1.15 You can use the Image Stack rendering feature in Photoshop CS3 to 
blend multiple images together and automatically remove varying features (such as 
people walking through the scene). This finished picture was retouched only slightly, 
in order to remove a few remaining ghost-like traces from the picture.
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New Smart Object features
The new Open as Smart Object command makes the Smart 
Object process a lot more accessible. When you place an 
image, or convert a layer to become a Smart Object, a range 
of non-destructive edit options will be at your disposal. 
As before, you can apply free transform adjustments to 
Smart Object layers so that you can scale an image layer 
up or down in size without permanently resizing the layer 
pixels. But Smart Objects will also now allow you to render 
images via Stacks (see preceding page) or apply Smart 
Filters to a Smart Object. 

Smart Filters
When you create a Smart Object, the pixels are always 
preserved in their original state and as a result of this, 
Smart Objects can now be used to apply filter effects that 
are fully editable. This means that when you create a Smart 
Object (or choose Convert for Smart Filters from the Filter 
menu), you can select the Smart Object layer, choose a 
filter effect, and the filter will be applied to a rendered 
version of the original layer and appear as a Smart Filter 
layer associated with the same Smart Object layer. This lets 
you preview the result of any filter effect as applied to the 
selected layer. If you want to make any further changes, 
you then have the ability to double-click the Smart Object 
filter layer to call up the Filter dialog for the filter effect. 
This will allow you to re-edit the filter settings as many 
times as you want, add extra filter effects to the Smart 
Object layer, drag and drop the order in which the filter 
effects are applied as well as drag and drop them from one 
Smart Object layer to another. Note that you can also use 
the O A key as you drag to copy filter effects between 
Smart Object layers. Each Smart Object layer will also 
have a single layer mask, which means that the Smart 
Filter masking is always applied to all Smart Filter layers. 
But you can’t directly link a layer mask to a Smart Object, 
although there are a couple of workarounds that will allow 
you to do so if you wish to move both a Smart Object 
layer and mask in register. I will be providing tips on these 
techniques later in the book in Chapter 8.

Editable shadows/highlight
Up until now it has not been possible to 
edit shadow/highlight adjustments, but 
you can do so now by using the Convert 
for Smart Filters command, or when 
editing an existing Smart Object.

More discoverable
Smart Objects first appeared in Photoshop 
CS2 but many people never got around 
to working with them, mainly because the 
Group into Smart Object command was 
obscurely hidden in the Layer palette menu 
and also because it was not easy to open a 
new image directly as a Smart Object. For 
example, with CS2 you first had to create 
an empty new document with the exact 
pixel dimensions before you could place 
an image (such as a raw file) as a Smart 
Object. With Photoshop CS3, you can now 
place a raw capture file as a Smart Object 
layer in a single step.
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Figure 1.16 In this example I opened a raw DNG image as a 
Smart Object and added a normal pixel layer of a backdrop image, 
which I then converted to become a Smart Object layer. I then 
added a layer mask to reveal the model on the layer below (see 
Chapter 8 for instructions on how this was done). Once a layer 
or group of layers have been converted to a Smart Object, one 
can then apply Smart Filters. Here, you can see how I applied a 
Lens Blur filter to the Smart Object and applied a gradient to the 
Smart Filters mask to reveal some of the unsharpened detail in the 
original pixel layer.

Client: Indola. Model: Pernille @ Storm.
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Quick Selections
The quick selection tool is grouped with the magic wand in 
the Tools palette and takes priority as being the default tool 
for making magic wand type selections, To make a quick 
selection you simply drag with the tool to select a sample 
range of colors from an image, either selecting pixels from 
a single layer or sampling all layers. From this, Photoshop 
will calculate a rough selection of pixels that you can 
further modify by using the refine edge options.

Figure 1.17 The quick selection tool options.

Refine selection edges
If you click on the Refine Edge button, you can refine the 
selection edges using the dialog slider controls. A much 
better way to use Refine Edge is to convert a selection to 
a layer mask first and then select Refine Edge... from the 
Select menu.

1 In this example I chose the quick selection tool, set a sample area size and 
dragged with the quick selection tool to define the areas I wished to include in the 
selection.

Refining layer masks
You can build up a quick selection by 
repeatedly dragging across the image 
areas you wish to include in the selection 
(there is no need to hold down the S 
key), but hold down the OA key to 
subtract from a quick selection.
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2 I then moused down on the adjustment layer menu to add a radial Gradient Fill 
layer using the colors shown here. This single step automatically converted the 
quick selection into a layer mask.

3 As long as the layer mask is selected, you can fine-tune the mask by going to 
the Select menu and choosing Refine Edge... In the example shown here, I used 
Ch Lh to hide the marching ants and was able to preview the Refine 
Edge adjustments on a layer mask that was actively masking the Gradient Fill layer.
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Vanishing Point 2.0
The Vanishing Point plug-in was an interesting addition 
to the Photoshop CS2 program, because it allowed you 
to retouch and place images so that they matched the 
perspective in the original photograph. Vanishing Point has 
been updated in CS3 to include some extra new features. 
Now when you import image data into the Vanishing Point 
modal dialog you can wrap images around multiple pre-
defined plane surfaces. And there is an angle control that 
can be used for positioning linked planes at angles other 
than 90º. This means you can define complex geometric 
surfaces, import an image and paste the image data across 
more than one plane surface at a time. Plus you can also 
use the transform tool to rotate a pasted selection before 
placing it.

3D support
Photoshop allows you to open and work 
live in Photoshop with 3D files created 
by programs like Acrobat 3D, 3D Studio 
Max, and Maya. Supported 3D file formats 
include .U3D, .3DS, and Sony Collada.

Figure 1.18 The Vanishing Point 2.0 dialog showing angled plane selections.

Extended version only
Only the Extended version includes the 
measurement tools described here and 
allows Vanishing Point data to be exported 
using the DXS format export geometry  
and planes, and also use the 3SD format to 
export geometry and textures from  
an image.
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Printing
Printing from Photoshop has been much improved and 
there are features included in Photoshop CS3 that will most 
please the professional users.
	 The Print with Preview has now become the Photoshop 
Print dialog, from where you can select the printer model 
to print to, access the system Page Setup dialogs and set 
the paper orientation. At long last, the preview image is 
now properly color managed. What you see in the preview 
is more representative of what the print will look like and 
will adjust to reflect any changes made to the printer profile 
selection or rendering intents. If you are using the Print 
dialog to produce a proof print that simulates a CMYK 
press setting or proofing device, you can access any pre- 
saved custom proof condition settings from directly within 
the Print dialog, plus you can turn the color managed 
display on or off by checking or unchecking the Match 
Print Colors checkbox.

Figure 1.19 The new Photoshop CS3 Print dialog.
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Bridge 2.0
Bridge 2.0 is undoubtedly an improvement, especially 
as some of the frustrating bugs that were in version 1.0 
have now been resolved. The first thing you will notice 
is the new look interface. The dark gray theme offers 
better contrast for viewing images and the design layout 
is flexible enough to allow you to customize the way the 
panels are laid out almost any way you like. There are 
some nice refinements in the way the metadata information 
is displayed and the Preview panel now provides a properly 
color managed preview of selected images.
	 The new Filter panel provides extensive image filtering 
options and file search times have improved, allowing you 
to filter images with a single mouse-click using criteria 
such as file type, keywords, image rating and orientation. 
The Slideshow view mode has also been updated, offering a 

Figure 1.21 The Bridge 2.0 interface.

Figure 1.20 The Bridge 2.0 Preview panel 
provides accurate color managed previews with 
smooth rendering and the ability to display a 
selected group of images at once and has a loupe 
tool for close-up 1:1 previewing.
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choice of slide transitions but with less confusing controls, 
plus the new ability to zoom into images to check sharpness. 
Within the Content panel you can organize files better, 
grouping them into stacks so that they can be quickly 
expanded or collapsed.
	 Up until the beginning of 2006, I had been using 
Bridge 1.0 in conjunction with Camera Raw to manage 
my digital workflow for everything from capture through 
to print, using Bridge as my main program for importing, 
file browser management and as a digital asset manager to 
manage my image library. As the number of photographs I 
was shooting each day increased and the library collection 
grew in size, the task of carrying out all these jobs in 
Bridge got harder. The main problems with Bridge 1.0 
were: that it lacked an automated import procedure, 
the length of time it took to generate contact sheets and 
Web photo galleries, plus the awkwardness of inputting 
metadata. Bridge 2.0 is now better because the thumbnail 
navigation is faster and the Previews can be made to 
display a properly color managed preview. But on the other 
hand, not enough has been done to improve upon these 
other, more pressing concerns. At the time of writing, the 
new Photo Downloader plug-in has the potential to offer 
good automated camera file importing, but unlike other file 
importers, it fails to provide proper control over the file 
renumbering. All print outputs have to be processed via 
Photoshop, which means that the contact sheet generation 
is still very much reliant on Bridge having to open every 
image fully via Camera Raw or Photoshop in order to 
render contact sheet sized images. Other programs, like 
Adobe Photoshop Lightroom, can generate their contact 
sheets in a hundredth of the time it currently takes Bridge. 
The file searching does make Bridge a more effective 
asset manager, but the metadata input process remains 
as cumbersome as it was before. Adding custom IPTC 
metadata or custom keywords can still be a rather slow 
process, although the Filter panel does now make good use 
of that metadata information.

Figure 1.22 The Bridge Filter panel provides 
more comprehensive controls for filtering images 
by.
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	 My impression of Bridge 2.0 is that it has certainly 
improved as an image browser, in that it offers better 
browsing and some new additional digital asset 
management features that are worth taking note of. 
However, for professional-level file imports and full 
asset management, I suggest you need something like 
the Photoshop Lightroom program but, for basic image 
browsing, Bridge 2.0 does offer some useful extra built-in 
functionality for Photoshop.

PDF enhancements
The PDF presentation automated plug-in has also been 
updated. PDF presentations are easier to create out of 
Photoshop CS3 and let you include extra items in your 
presentations such as background colors, add filename and 
extension, title, copyright info, author, description, EXIF 
info (Exposure F stop and Exposure time), plus annotations 
(that were in the original file).
	 And when saving files using the Photoshop PDF 
format, you can save them using the PDF 1.7 (Acrobat 8 
compatible format).

Device Central
Device Central is a separate application that is included 
with the Photoshop and Bridge CS3 package that allows 
you to create and view image files for a variety of mobile 
devices, such as cell phone devices. You can open Device 
Central via the File menu in Photoshop, select a particular 
device and create a new document with the exact pixel 
dimensions for that device. When you are editing an image 
you can go to Save for Web and click on the Device Central 
button where you can use the Emulator panel to preview 
how an image or design graphic might look on one of the 
many mobile phone presets supplied.
 Figure 1.24 Here is a view of the Emulator 

panel in Device Central, showing a preview of 
the book cover, as it might appear on a mobile 
phone display.

Figure 1.23 PDF Presentation dialog includes 
new options.
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Overall impressions
After two years of waiting for this latest upgrade, 
Photoshop customers might well expect some major new 
features in this latest release. But at the same time, when 
new operating systems or computer hardware changes 
require a revision of the existing code, the task of keeping 
all the code up to date becomes increasingly harder. This 
is exactly what happened when Apple decided to adopt 
the Intel chips for the Mac platform. The Photoshop 
engineers were obliged to do a complete recompile of 
all the existing Photoshop code just to keep pace with 
this change. Consequently, Macintosh users will now be 
able to appreciate the real benefits of faster Photoshop 
performance on the latest Intel Mac computers, while PC 
customers will gain the narrower benefit of improved, 
faster startup times.
	 Apart from this, the engineering team have still 
managed to come up with a larger number of new 
features. I have highlighted some of my favorites in this 
introductory chapter. I have not included every new feature 
because not all these will necessarily be of interest to stills 
photographers. The new Camera Raw 4.0 plug-in shares 
the same new image adjustment controls as will be found 
in the Adobe Photoshop Lightroom program. And as was 
pointed out, these new Camera Raw controls can now be 
applied to any image, not just to raw files. Therefore I 
would say that if you were to buy only Photoshop CS3, 
then there is actually quite a lot to offer photographers in 
this upgrade of Photoshop. If on the other hand you intend 
to buy Lightroom, or will choose to rely on some other 
third-party program to process and manage your digital 
captures, then there may be less compelling reasons for you 
to upgrade.
	 My own personal view is that I like the new Photoshop 
CS3 interface design very much. I am also enthused by 
the new things you can do with features such as the Align 
Content feature and how this has been implemented to 
enhance Photomerge, HDR imaging and of course the 
new Image Stacks processing, which have all featured in 

The Extended version of Photoshop
Photoshop CS3 is sold as Standard 
and Extended versions. The Extended 
release includes what are regarded as the 
advanced features that are designed to 
meet the needs of dedicated users such as 
scientists, architects, forensics users and 
people who regularly work with HDR files 
in the movie industry. While the Extended 
version will be sold at a premium price, 
many of those customers who chose to 
buy the full Creative Suite package will  
find that their upgrade will include the 
Extended version of Photoshop.
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this introductory chapter. I would also rate the new Clone 
Source palette for providing accurate clone control, the 
Black and White adjustment and new Curves dialog and 
even Brightness/Contrast, for improved pixel editing. 
The Refine Edges command has a lot of great potential, 
especially as you can use it to edit layer masks as well as 
selections. In my opinion, these new features all provide 
practical tools for photographic Photoshop users. The 
only drawback is that things like Image Stacks (which I 
find really useful) are only available with the Extended 
version. I am less enthusiastic about Live Filters, because 
it seems like a lot of overhead in terms of increased file 
sizes and processing times, for not much gain. And the 
inability to link a mask to a Smart Object does limit Smart 
Object functionality. I am also rather lukewarm over Bridge 
2.0. During this particular test cycle I could not help but 
directly compare the usefulness of Bridge 2.0 alongside 
the new workflow capabilities of Lightroom. None of this 
personally matters to me so much, because I now mostly 
rely on using Lightroom to process all the file imports and 
manage my photographic library collection. I just happen 
to think that more resources could have been put into 
redesigning Bridge to make the workflow process easier to 
manage and faster, rather than adding things like a loupe 
tool in the Preview panel, which does not necessarily 
function as well as the zoom controls that are available in 
other programs. But that said, when you get Photoshop 
CS3, you will be acquiring the mighty Camera Raw 
processing plug-in which will now let you process over 150 
different raw file formats. Camera Raw 4.0 will definitely 
be providing a big upgrade here. I think I am being fair 
in pointing out what I believe to be the shortcomings in 
this release. But despite these reservations, I do believe 
Photoshop CS3 still has a lot to offer photographers 
everywhere.

Important notice
This extract is taken from Martin Evening’s 
forthcoming book: Adobe Photoshop CS3 
for Photographers. The contents of this 
PDF are made available for free on-line 
distribution, but may not be modified, 
sold, reproduced or distributed without 
prior permission from the author.


